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1.1 Overview

TUBA (Transport Users Benefit Appraisal) is a computer program developed for DfT to undertake an 
economic appraisal for a multi-modal transport study.

The aim of TUBA is to carry out economic appraisal in accordance with the DfT’s Transport Analysis 
Guidance (http://www.dft.gov.uk/webtag/documents/expert/pdf/unit3.5.4.pdf). This implements elements of 
the Sugden method. Details of the method, as implemented in TUBA can be found in Section 3.5.3 of 
WebTAG1. 

TUBA undertakes a matrix-based appraisal with either fixed or variable trip matrices. It takes trip, time, 
distance and charge matrices from a transport model. These matrices may be disaggregated by vehicle 
type, purpose, and person type. The user also inputs other costs associated with the do-minimum and do-
something schemes. TUBA will then calculate the user benefits in time, fuel vehicle operating costs (VOC), 
non-fuel VOC and charge; operator and government revenues; and the scheme costs, discounted to the 
present value year. Values calculated from input model data will be interpolated and extrapolated to cover 
the full appraisal period as necessary. The output file contains all these results for various degrees of 
disaggregation and also presents the data in a series of summary tables showing the economic efficiency 
of the transport system, known as TEE tables. Results are reported as perceived costs and market prices.

TUBA does not calculate benefits that are due to changes in accident costs.

1.2 Contacts

News of latest developments and updates for TUBA can be found on website:

http://www.dft.gov.uk/tuba/

Contacts for support on the application of TUBA are:

Principles of TUBA:
Integrated Transport Economics and Appraisal division
Department for Transport
Zone 3/04
Great Minster House
76 Marsham Street
London
SW1P 4DR

tel: 020 7944 6179
fax: 020 7944 2198
e-mail: itea@dft.gsi.gov.uk

_________________________
1 http://www.dft.gov.uk/webtag/documents/Expert/pdf/unit3.5.3.pdf

1 Introduction
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Running TUBA:
Manilla Wisten
Mott MacDonald 
Spring Bank House 
33 Stamford Street 
Altrincham 
Cheshire 
WA14 1ES

e-mail: tuba@mottmac.com

The rest of this manual is laid out as follows:
¡ Chapter 2: Information on installing TUBA
¡ Chapter 3: An overview of the operation of TUBA
¡ Chapters 4 & 5: Detailed information on setting up the scheme and economics files
¡ Chapters 6: Explanation of TUBA output
¡ Appendices A-F: Format specifications for input and output files
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The TUBA installation file is supplied on CD, via email or by download from the TUBA website. It has a file 
name of the form TUBA_18a.EXE. If you receive the software on CD the installation process should start 
automatically on inserting the CD into the drive. If this does not happen, or you have received the software 
through a different medium you will need to run the installation program manually.

By default the files will be stored on the C drive on the computer in the ‘Program Files’ directory in the sub-
directory ‘TUBA’. To uninstall the program, use Add/Remove Programs from the Control Panel. 

The standard economics data file, which is consistent with WebTAG Unit 3.5.6 will be copied to an 
\economics\ subdirectory.

The TUBA manual (this document), the TUBA guidance note (which provides guidance on producing data 
for TUBA from a transport model), a description of the demonstration data, a list of frequently asked 
questions (FAQs) and a guidance note on checking results will be placed in a ‘manuals’ subdirectory.

A ‘papers’ subdirectory contains two TUBA-related papers from the 2001 European Transport Conference.

Documentation and papers are in pdf format which can be read using Adobe Acrobat Reader (available 
free from www.adobe.com/reader). 

Demonstration data will be installed into the directory c:\TUBAdemo\. 

Approximately 10Mb of disk space is required for the installation.

2.1 System requirements

To run TUBA we recommend the following as a minimum specification;
¡ Windows XP/Vista
¡ 256Mb RAM (although large problems will benefit from extra RAM)
¡ 10Mb Hard Disk space (for installation)

The amount of disk space required for storing results will depend on the number of zones in the transport 
model and the level of disaggregation of the input data. For TUBA runs with large data sets extra RAM can 
give significant improvements in run time.

2. Installation
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3.1 Overview

TUBA is controlled via two main input files and outputs two files. Data from the transport model, in the form 
of matrices of trip numbers, distances, times and charges are also required.

The two main input files are:

¡ Economic parameters file: This contains data such as values of time, VOC coefficients, tax rates and 
economic growth. It also contains standard categories for mode, vehicle type, trip purpose etc. A 
standard file is supplied by ITEA division of DfT. Users may edit this file to suit the needs of their study.

¡ Scheme-specific file: This contains data specific to the scheme being modelled, such as the scheme 
costs. It is also used to specify the trip and cost matrices generated by the transport model.

Both these input files can be created and edited via the user interface. Alternatively a text editor program 
can be used.

A standard output file (.out) is produced containing the following information:
¡ List of errors and warnings during the program execution
¡ Summary of input information
¡ Tabulations of scheme costs
¡ Tabulations of user benefits, government and operator revenues by various categories
¡ Summary information in TEE (Economic Efficiency of the Transport System) format

A second output file (.tbn) presents time benefits broken down by the change in travel time and trip 
numbers for each OD.

In addition there is an option to produce a detailed results file in binary format containing fully disaggregate 
results which can be interrogated via the user interface.

The names of the input and output files are defined via batch files with a .BAT extension. The contents of 
these batch files are edited in the user interface via the Run->Settings menu (see Section 3.5). 

3.2 Starting TUBA

The TUBA installation process automatically creates a shortcut to TUBA on the Windows desktop. 
Alternatively, TUBA can be started from the Start menu, Start->Programs->TUBA.

On starting TUBA the user is presented with the screen shown in Figure 3.1 below:

3. Running TUBA
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Figure 3.1: Initial TUBA screen

This is a standard Windows interface with a menu bar and toolbar buttons for the most common operations. 
Placing the cursor over a button will display an explanation of its operation.

3.3 File menu

Under File are the usual options found with Windows software:
¡ New
¡ Open
¡ Close
¡ Save
¡ Save As
¡ Exit

plus a most recently used file list. Save and Save As apply separately to each of the batch, scheme and 
economics files.

This menu is used to create, open and save TUBA batch files and to exit the program.

Selecting File->New brings up the following Run Settings template:
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Figure 3.2: Run settings template

This is used to define the input and output file names, which may be typed directly or selected using the 
standard Windows ‘Browse’ dialogue. By default the standard economics file supplied with the software will 
be defined in the ‘Economic Parameters File’ box.

The economics and/or scheme file names can be left blank if either is to be created from scratch. After 
editing these they should be saved using the File->Save As options. A results file must be specified before 
TUBA can carry out its calculations.

Once these filenames have been defined and after clicking OK they can be saved to a batch file using File-
>Save Batch or File->Save Batch As.  Saved batch files can be re-opened and edited. 

File->Save All saves the batch file and any changes to the scheme or economics files. The batch, scheme 
or economics files can be saved under different file names using the File->Save As command.

When opening a batch file, or changing the scheme or economics file, the files are checked for errors. A 
message will be displayed if there are any problems. Details can be viewed from the View >Warnings 
menu.

The option ‘Run one user class at a time’ can be used to reduce memory requirements and should be 
selected in cases where there is insufficient RAM and Windows is using a lot of virtual memory. In cases 
where there is sufficient RAM using this option will slow down the software slightly.

The Run Settings template is also accessed from the Run->Run Settings menu.
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3.4 Data entry and editing

Economics data can be edited by selecting ‘Economics’ on the menu bar and then selecting an appropriate 
sub menu. A full description of the different types of economic data can be found in Chapter 4.  Similarly, 
scheme data is edited by selecting ‘Scheme’ from the menu bar. Full details are given in Chapter 5.

All data input screens have a similar format. The example in Figure 3.3 shows the value of time input table. 
The template is like a simple spreadsheet, with the user being able to edit the white areas. Clicking the 
Help button will bring up information to aid completion of the current table.

Navigation between cells is via the Tab and Shift-Tab keys to move right and left and the up and down 
cursor keys to move up and down. In the larger tables a scroll bar is also used.

Data in individual cells can be copied and pasted via the menu brought up by right-clicking the mouse when 
the cursor is in the appropriate cell. Alternatively the whole table can be copied or pasted using the copy 
and paste buttons on the toolbar. This allows transfer of data to or from a spreadsheet.

Figure 3.3: Example data input screen
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3.5 Run 

The Run menu has three sub-menus:
¡ Run settings: to select or change the name of the input and output files

¡ Run now: to carry out the TUBA calculations (after input and output file names have been defined). On 
completion a summary of errors and warnings will be displayed. Any errors encountered will cause the 
program to stop and will need to be rectified. Warnings and serious warnings represent possible 
anomalies in the input data and warrant further investigation by the user.

¡ Run batch: to open a TUBA .GRP file containing a list of TUBA runs. This enables a sequence of TUBA 
runs to be carried out without user intervention. The ‘Run Batch’ option is only available if a TUBA file is 
not already open in the GUI. The .GRP file contains a list of individual TUBA .BAT files, e.g.:

C:\TUBADEMO\EXAMPLE1.bat
C:\TUBADEMO\EXAMPLE2.bat
C:\TUBADEMO\EXAMPLE3.bat

3.6 Analysis

The Analysis menu gives the user the opportunity to interrogate the fully disaggregate results that are 
stored in the binary file (provided the option for detailed results was set in the scheme file). This facility 
selects the data that matches the criteria set by the user and outputs them to a CSV format file. This can be 
opened in any spreadsheet package for further analysis or for plotting graphs.

More details are given in 6.4.

3.7 View

Using the view menu it is possible to open the input and output files with the default Windows text editor. 
This feature should not be used to edit the input files - either use the user interface or close down TUBA 
and use your preferred text editor.

3.8 Help feature

The TUBA help system can be accessed in two ways. From the Help menu the entire help file is opened 
and can be searched for keywords. Alternatively clicking the Help button in a template will bring up context-
sensitive help, giving guidance on that particular data table. 
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4.1 General

The economics (and scheme) input file is an ASCII file consisting of a series of data tables. Each of these 
tables can be defined interactively via the user interface. Appendix A contains detailed data table formats 
for the economics file.

Certain features of data entry are common to several tables. These are explained in the following sub-
sections.

4.1.1 Percentages

Where data is entered as percentages, for example growth rates, a value of, say, 20 is interpreted as 20%; 
0.2 would be interpreted as 0.2% and not 20%.

4.1.2 Growth rates

Growth rates are required for a number of economic data. The common format is: start year, end year, rate 
(as % p.a.), e.g.:

Start year End year Rate
1999 2005 5
2006 2010 4

The interpretation of this is as follows: the 1999 value is 5% higher than the 1998 value. the 2000 value is 
5% higher than the 1999 value and so on, up to the 2005 value being 5% higher than the 2004 value. Then 
2006 is 4% higher than 2005 and so on. Where several periods with different growth rates are defined, they 
must not overlap. 

Any growth defined after the appraisal horizon year will be ignored and a warning message issued.

4.2 Parameters

The following parameters are defined:

TUBA version The current TUBA version. This is used to identify the format of the file and 
should not be edited.

Base year The base year for economic parameters. The standard value is 2002, 
meaning that VOT, value of fuel, etc. will be defined in 2002 prices and 
values. Outputs will be reported in base year prices.

Present value year The year to which costs and benefits will be discounted

RPI in base year The value of the Retail Price Index in the economic base year. This is to 
allow scheme costs input in a different price base to be converted to base 
year prices.

4. Economics data
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Average indirect tax rate The average rate of indirect taxation in the economy. This is used to 
convert from factor costs to market prices.

Base year carbon values The value, in pounds, of 1 tonne of carbon emissions in base year prices; 
low, high and central values must be provided, in that order.

4.3 Category

The categories are
¡ Mode
¡ Vehicle type/submode
¡ Purpose
¡ Person type
¡ Fuel type

These categories serve two purposes. Firstly, the input and output data in TUBA can be disaggregated by 
category. Secondly, some of the economic parameters will vary by category; for example, value of time 
depends on person type, vehicle type and purpose.

4.3.1 Mode

Mode is the top level of aggregation in TUBA. It is primarily used for reporting purposes, although scheme 
costs are defined by mode. Results in the TEE table are disaggregated by mode.

Up to 5 modes may be defined. Each mode is given a name for reporting purposes.

4.3.2 Vehicle type/submode

Vehicle type/submode is a further disaggregation of mode. In TUBA separate trip and cost data have to be 
defined for each vehicle type/submode. Submode is a public transport equivalent of vehicle type. For 
example, in the standard settings ‘rail’ is a main mode with two submodes: ‘light rail’ and ‘heavy rail’.

Up to 10 vehicle types/submodes can be defined. Each vehicle type/submode is allocated to a particular 
mode for reporting purposes. 

Any new submodes or vehicle types are identified by entering ‘Y’ in the ‘New submode?’ column. A new 
submode is one that does not exist in the standard DM scenario, a typical example being the introduction of 
a new LRT line. For these submodes it is still necessary to define so-called pseudo-DM data. For further 
details of how to deal with new submodes in TUBA please see the user guidance document.

Park and ride submodes are identified with a ‘Y’ in the ‘P&R?’ column. This will affect the calculation of 
vehicle operating costs. Please see the user guidance document for more details on appraising park and 
ride schemes with TUBA.

Each vehicle type/submode must be identified as being used for personal travel (‘per’) or freight travel 
(‘fre’). This is for reporting purposes only and does not affect the benefit calculations.

The following economic data will depend on vehicle type/submode:
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¡ Value of time
¡ VOC coefficients
¡ Charge tax rates (i.e. taxes on fares, tolls, parking charges etc.)
¡ Non-fuel VOC tax rates 
¡ Default purpose splits
¡ Default person type factors (i.e. vehicle occupancies)

4.3.3 Person type

The two person types currently defined in the standard economic parameters file are ‘driver’ and 
‘passenger’. A more disaggregate classification of person type can be used, for example to provide a more 
disaggregate application of values of time.

Up to 20 person types can be defined. Each person type must be identified as being either a driver (D) or a 
passenger (P), with the latter including both private vehicle and public transport passengers. This is to aid 
conversion between vehicle and person trip matrices.

For data from a public transport model it is expected that all data will be for ‘passenger’ person type. Data 
from a highway model data will probably be for ‘vehicles’. In this case an ‘all person’ type is used and 
standard person type factors are used to calculate mean values of time per vehicle. 

Help on dealing with bus drivers and passengers can be found in the TUBA guidance document.

The following economic data depend on person type:
¡ Value of time

4.3.4 Purpose

The disaggregation of data by purpose is important in TUBA because different formulae are used for 
business and consumer trips. If the transport model does not contain data disaggregated by purpose, 
standard purpose splits are defined in the economic parameters file which are applied to ‘all purpose’ data 
from the model.

Up to 10 purposes may be defined. In addition to being allocated a descriptive name each purpose must be 
identified as being business (B) purpose, consumer (C) purpose or other (O) purpose.

The following economic data depend on purpose:
¡ Value of time
¡ Default person type factors
¡ Non-fuel VOC coefficients

4.3.5 Fuel type

In the current version of TUBA only two fuel types, petrol and diesel, are defined. Since these are fixed it is 
not possible to change them via the user interface. 

The following economic data depend on fuel type:
¡ Fuel costs, including tax rates
¡ Fuel consumption coefficients
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4.4 Time period

The standard economic file defines 5 standard periods:
¡ AM peak (0700-1000)
¡ PM peak (1600-1900)
¡ Inter-peak (1000-1600)
¡ Off-peak (1900-0700)
¡ Weekend (All hours)

Up to 10 time periods can be defined. In addition to a descriptive name for reporting purposes, additional 
comments can be made for each period.

Time periods are a broad categorisation for reporting purposes. It is recognised that certain models will 
have a more detailed representation of time; this is allowed for in the Time Slices section of the scheme 
file.

The following economic parameters depend on time period:
¡ Purpose split
¡ Person type factors (vehicle occupancies)

4.5 Breakpoints for reporting of benefits

The economics file specifies some breakpoints to allow benefits to be broken down by trip length and size 
of time saving. The format of the table is given in Appendix section A.9.

The table has two rows specifying:

¡ Distance breakpoints (in kilometres) and
¡ Time saving breakpoints (in minutes).

4.6 Charges

Different types of charges can be defined. User charge benefits and operator revenues will be reported 
separately for each charge type. This allows the user to distinguish between, for example, the effects of 
inter-urban tolls, cordon charging, and car park charges.

As well as a description of each charge type it is necessary to use a three letter code to specify whether the 
revenues from the charge are received by the private sector (‘pri’), central government (‘cen’) or local 
government (‘loc’).

4.7 Discount rate

This table defines the rate at which costs and benefits are discounted. Discount rates may vary over time. 
Each line of the table defines a period over which the discount rate is constant, along with the start and end 
years (inclusive) of the period.  The start and end years are defined with reference to the current year (as 
defined in the scheme file), so that year ‘1’ is the current year, year ‘2’ is the current year plus 1 etc.

Discount rates between the present value year and the current year are assumed to be the same as in the 
current year.
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4.8 Value of time

4.8.1 Base

The value of time (VOT) is used to convert time savings in, for example, minutes to monetary values. It 
depends on the submode, person type and trip purpose. These categories must have been set up before 
the user can enter VOT data.

VOT should be entered in pence per hour (p/hr) in perceived costs for business and consumer trips. Note 
that for business trips perceived costs will be the same as resource costs and are therefore not in market 
prices.

If VOT is not defined for a particular submode/person type combination it is assumed to be zero.

4.8.2 Growth

VOT growth is defined using the standard TUBA format (see Section 4.1.2). Different growth rates may be 
defined by purpose, but within each purpose the same rate applies to all submodes and person types.

In accordance with the Treasury’s Green Book VOT growth rates for a given year are modified according to 
whether the discount rate for that year is different from the rate for the current year (defined in the scheme 
file) as follows:

yearcurrent_atediscount_r
yearatediscount_r

yearoriginalVOTgrowth_yearmodifiedVOTgrowth_ ×=

If the current year discount rate is zero the VOT growth rates will not be modified.

4.9 Taxes

Taxes are used to convert between resource and perceived costs, to adjust values to market prices and to 
calculate government indirect tax revenues. The user is referred to the TUBA guidance document for an 
explanation of these terms.

The following tax rates are defined (together with growth rates for calculating future year tax rates):

¡ Fuel tax (duty and VAT)
¡ Tax on non-fuel VOC (final and intermediate consumption)
¡ Tax on user charges (final and intermediate consumption) (depends on charge type)
¡ Average rate of indirect taxation

In general the tax rate on intermediate consumption is that paid by business trips and includes duty, but not 
VAT. The final consumption rate is paid by consumer trips. For fuel, duty is paid by all trips but only non-
fuel trips pay VAT.
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The average rate of indirect taxation is used to convert business trip benefits and scheme costs to market 
prices.

4.9.1 Average indirect tax changes

This table defines the forecast growth rates for the average indirect tax rate using the standard TUBA 
format (see Section 4.1.2). 

4.9.2 Base non-fuel VOC Tax Rates 

This table defines the tax rates on non-fuel vehicle operating costs.

Rates must be defined for both intermediate and final consumption. 

These tax rates depend on vehicle type/submode.

All tax rates are defined as percentages.

Vehicle types must have been defined before data can be entered in this table.

4.9.3 Growth in non-fuel VOC Tax Rates

This table defines growth rates for non-fuel VOC tax rates using the standard TUBA format (see Section 
4.1.2. Growth rates depend on vehicle type/submode.

4.9.4 Base Charge Tax Rates 

This table defines tax rates on user charges in the base year. Tax rates may differ by charge type.

Rates must be defined for both intermediate and final consumption. 

Charge types must have been defined before data can be entered in this table.

4.9.5 Growth in Charge Tax Rates

This table defines the change in tax rates on user charges using the standard TUBA format (see section 
4.1.2). Tax growth rates may differ by charge type.

4.10 Fuel

4.10.1 Cost

This table defines the following elements of cost for each fuel type for the base year:
¡ Resource cost (p/litre)
¡ Duty (p/litre)
¡ VAT (%)
¡ Carbon emissions (grams per litre of fuel used)
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4.10.2 Cost changes

This table defines the changes in the different cost elements (resource, duty and VAT) for each  fuel type.

The last column of this table specifies percentage changes in carbon content of vehicle/fuel type 
combinations in order to reflect the impact of biofuels on carbon emissions. 

4.10.3 Consumption

This table defines the a, b, c and d fuel consumption coefficients for each vehicle type and fuel type. These 
give fuel consumption in litres per km when applied to the following formula:


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where D and T are the distance in kilometres and the time in hours. The maximum value of D/T is restricted 
to the cut-off speed specified in the last column of the fuel consumption table for fuel consumption 
purposes.

For park and ride vehicle trips the fuel consumed per km is

V3dV2cVbVaconsumedFuel 




 +++=

where V is the park and ride speed defined in the scheme file (see section 5.1).

If no vehicles exist for a particular fuel type/vehicle type combination then no coefficients need to be 
defined.

For certain submodes, e.g. rail, the VOC formula will not be applicable, in which case no parameters need 
be defined and no VOC benefits will be calculated. Operating costs for these modes will need to be 
obtained from other sources.

Note that VOC benefits will not be calculated for ‘passenger’ person types.

4.10.4 Efficiency

This table defines the increase in fuel efficiency by vehicle type and fuel type.

Increases in fuel efficiency correspond to a reduction in fuel consumption. A 10% increase in fuel efficiency 
is interpreted as a 10% reduction in fuel consumption for a given journey.

4.11 Carbon value changes

This table defines how the cost of carbon emissions changes over time. Growth may be defined either as a 
rate in % per year, or in absolute terms in £ per year; it is not possible to define both for the same range of 
years.
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The same growth is applied to the low, central and high base year values.

4.12 Fleet

4.12.1 Base

This table defines the base year fleet composition, that is, for each vehicle type, the proportion of vehicles 
of each fuel type. For each vehicle type the sum of the proportions across all fuel types should be 100%.

4.12.2 Changes

This table defines the changes in fleet composition over time. If there are N fuel types changes are only 
specified for the first N-1 fuel types. Changes for the Nth fuel type are calculated automatically to ensure 
that the fleet composition summed over all fuel types is 100% for each vehicle type.

Note that if the base year proportion of a particular fuel type is 80% and this decreases by 10% in the next 
year then the proportion in this second year will be 72% (not 70%).

4.13 Non-fuel VOC parameters

4.13.1 Base

This table defines the a and b resource non-fuel VOC coefficients by vehicle type for business and 
consumer trips. These are used to calculate non-fuel VOC resource costs using the formula:

bTaDVOCfuelNon +=−

where D and T are the distance in kilometres and the time in hours.

For park and ride trips the formula is









+=−
V

D
baDVOCfuelNon

where V is the park and ride speed defined in the scheme file (see section 5.1).

Different coefficients are used for business and consumer trips. 

For certain submodes, e.g. rail, the VOC formula will not be applicable, in which case no parameters need 
be defined and no VOC benefits will be calculated. Operating costs for these modes will need to be 
obtained from other sources.

Note that VOC benefits will not be calculated for ‘passenger’ person types.

4.13.2 Changes

This table defines types of change in non-fuel VOC costs. The same rate is applied to all coefficients.
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4.14 Purpose splits and person type factors

It is recognised that transport models are not always disaggregate enough to output results by trip purpose 
and that vehicle-based highway models may not contain data on occupancies. For this reason two types of 
default splits/factors are defined in the economics file. Where disaggregate model data are available they 
should always be used in preference to these defaults. Similarly, robust local data on purpose splits and 
occupancies should be used in preference to these national averages, by changing the values in the file.

4.14.1 Purpose splits

This table defines purpose splits by time period and submode. Splits should be entered as percentages. 
For each time period and submode the sum of splits across all purposes must be 100.

Purpose splits are used to disaggregate input  trip and cost data that has not already been disaggregated 
by purpose. This is necessary because of the different formulae used to calculate business and consumer 
trip benefits.

4.14.2 Person factors (Vehicle occupancies): base

Person factors are a generalisation of vehicle occupancies. They depend on vehicle type, purpose and time 
period. 

The person factors define the number of people of each person type for each submode/purpose 
combination, varying by time period. For example, if the person types are driver and passenger the driver 
person factor should always be 1. The passenger factor is the average number of passengers per vehicle.

Person factors can be summed over person types for a particular vehicle type/purpose/period combination 
to give occupancies. 

When input trip and cost data are not disaggregated by person type the person factors are used to 
calculate mean VOTs per vehicle. Results are reported as ‘all person types’ and are not disaggregated by 
person type.

4.14.3 Person factors: changes

This table defines the change in person factors by time period for each submode/person type/purpose 
combination. A default growth rate of 0% is assumed.

4.15 Preparation and Supervision Costs

If the user does not explicitly define preparation or supervision costs in the scheme file then these can be 
calculated by TUBA. This table defines preparation and supervision costs, by mode, as a percentage of the 
total land and construction cost. Preparation costs depend on the current stage of preparation, which is one 
of the following:

¡ SI (Scheme Identification)
¡ PC (Public Consultation)
¡ PR (Preferred Route)
¡ OP (Order Publication)
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¡ WC (Works Commitment)

For further details see the COBA manual (DMRB Volume 13): 13.1.2.7 – The Preparation of Cost Data for 
Use in COBA.
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Like the economics file, the scheme file is an ASCII text file consisting of a series of data tables that can be 
edited interactively via the user interface. Detailed format specifications for these tables can be found in
Appendix B.

5.1 Parameters

The following parameters are defined:

TUBA version The current TUBA version. This is used to identify the format of the file and should 
not be edited.

Run name A descriptive name for the TUBA run

Name of DM scenario A descriptive name for the DM scenario

Name of DS scenario A descriptive name for the DS scenario

First year The first year of the appraisal period, i.e. the first year for which user benefits will 
be calculated

Horizon year The last year of the appraisal period (normally First year +59 for a 60 year 
appraisal period)

Modelled years A list of all the modelled years, separated by spaces. Up to 6 years may be 
defined. If the first year and horizon year are not the same at least 2 modelled 
years must be defined. Modelled years should lie between the first and horizon 
years (inclusive).

Current year The year in which the TUBA run is being carried out. For automatic allocation of 
preparation costs this is the first year to which costs are allocated. It is also used to 
define 'year 1' for the discount rate table in the economics file.

Detailed results Yes/No - whether a binary file containing fully disaggregate results should be 
output. This file can be interrogated via the user interface

No. of warnings to print By default, this value is set to ‘All’ so that all serious warnings and error messages 
will be written to the outputs file. Setting this to a number will limit the number of 
warnings of each type that are output to that number.

P&R car speed The average speed of the car leg of park and ride trips. This is used in the VOC 
calculations for P&R submodes instead of calculating speeds from the time and 
distance matrices.

5. Scheme data
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Use zones as sectors If ‘Yes’ then TUBA creates a sectoring system equivalent to one zone per sector. If 
‘No’ then TUBA allocates all zones to a single sector. This does not affect the main 
.out output file, just the level of detail available in detailed results analysis. Note 
that setting ‘Yes’ is likely to significantly increase memory requirements and run 
time. This parameter has no effect for modes for which an explicit sector file has 
been defined.

5.2 Time slices

This table describes the time slices used in the model and how these correspond to the time periods 
defined in the economics file. The following data are required for each time slice:
¡ Duration of the time slice in minutes
¡ Annualisation factor
¡ Time period to which the time slice belongs
¡ Description

The annualisation factor is used to convert from benefits per time slice to annual benefits. The benefits in 
each time slice are multiplied by the annualisation factor and then summed to give annual benefits. The 
annualisation factor is therefore how many of this time slice there are in a whole year.

Advice on annualisation factors can be found in the TUBA guidance document.

5.3 Scheme Costs

The scheme costs entered should include all allowances for optimism bias as required by the Treasury 
Green Book. The appropriate adjustment factors for optimism bias at the different stages of a scheme 
should be obtained from the Overseeing Organisation. The definition of scheme costs is the same for both 
the do-minimum (DM) and the do-something (DS) and has 4 components:
¡ Scheme details
¡ Total costs
¡ Cost profile
¡ Delay costs

If costs for the DM or DS scheme are zero then no costs need to be defined.

5.3.1 Schemes

This table defines the following scheme data for each mode:
¡ The first year of construction
¡ The scheme opening year
¡ The scheme stage (SI, PC, PR, OP,  or WC – see Section 4.15 for explanation)

These data are used primarily for the automatic calculation and allocation of preparation and supervision 
costs.
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5.3.2 Costs

This table defines the total scheme costs. For each cost item the following are required:
¡ A one letter code for the type of cost: construction (C), land (L), operating (O), maintenance (M), 

grant/subsidy (G), preparation (P), supervision (S), developer and other contributions contribution (D)
¡ The mode to which the cost applies
¡ The sector which incurs the cost: private sector (pri), central government (cen) or local government (loc)
¡ The total cost in £000s
¡ Whether the cost entered is in factor costs (F) or market prices (M)  
¡ The RPI for the quarter used to estimate the total cost

For grant/subsidy and developer contribution costs only sectors ‘cen’ and ‘loc’ are allowed. For 
grant/subsidy this defines who makes the payment – it is assumed that the private sector always receives 
the payment. For developer contribution the interpretation is slightly different – the sector defines who 
receives the payment and it is assumed the private sector always makes the payment. Grant/subsidy and 
developer contribution costs should be entered as positive numbers.

If preparation or supervision costs are not defined for a particular mode then ‘default’ can be entered in the 
total cost column (the last two columns can be left blank) and they will be calculated automatically as a 
proportion of land and construction costs. Preparation costs will depend on the current stage of the 
scheme. Percentages for the calculation of preparation and supervision costs are defined in the economics 
file.

All costs will normally be entered as positive numbers.

For construction costs, account must be taken of any change in the cost of road construction relative to the 
general price level. This used to be done in TUBA by using the Relative Price Factor (RPF). However, the 
latest WebTAG guidance Unit 3.5.9 recommends the use of inflation rates relevant to the delivery of 
transport schemes. These should now be used in the preparation of base cost inputs for TUBA.

Updated values for RPI can be found on the National Statistics web site at 
http://www.statistics.gov.uk/STATBASE/tsdataset.asp?vlnk=7173 .

5.3.3 Profile

For each mode this table defines the percentage of the total costs for each cost type that occur in each 
year. Normally for a given mode and cost type the percentages should sum to 100 across all years.

For cost types preparation, supervision, land and operating there is the option of using default profiles. If ‘-
1’ appears anywhere in the cost profile for a mode and cost type then the default profile will be applied. In 
each case the default profile is flat, with costs allocated equally to the appropriate years as follows:
¡ Preparation: current year to year before construction starts (inclusive)
¡ Supervision: first year of construction to opening year (inclusive)
¡ Land:  all costs in first year of construction
¡ Operating: scheme opening year to appraisal horizon year (inclusive)
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5.3.4 Delay

This table defines the cost of delays during construction and maintenance. The costs are specified by year 
and mode and split between business, commuting, other and freight travel. They should be entered in 
thousands of pounds in base year market prices.

5.4 Benefit change

In accordance with Section 5.4 of WebTAG Unit 3.5.42 TUBA allows the user to define changes in the 
magnitude of benefits and revenues beyond the last modelled year. This is in addition to any change 
caused by economic factors, for instance growth in the value of time, and the standard extrapolation of 
benefits beyond the last modelled year (which is described in detail in the TUBA user guidance document). 

This table is used to define rates of change in benefits beyond the last modelled year, by vehicle 
type/submode and time period. The standard TUBA conventions on defining growth rates apply. Changes 
should only be defined for the years from the last modelled year up to and including the horizon year.

5.5 User classes

Most assignment models operate with different user classes, each of which may have different generalised 
cost functions. For compatibility TUBA also has user classes, with each user class representing a particular 
combination of vehicle type (or submode), purpose and person type. The main function of user classes is to 
define what data each matrix contains. Up to 32 user classes can be defined.

‘0’ can be entered for purpose, indicating ‘all purposes’, i.e. the data is not disaggregated by purpose. In 
this case the default purpose splits defined in the economics file are used to disaggregate the data.

‘0’ can be entered for person type, indicating that the data is not disaggregated by person type. This will 
most often be applied to data from a highway model where trip data is in vehicles. In this case, the default 
person splits (occupancies) are used to calculate the mean VOT per vehicle.

5.6 Matrices

For each user class and modelled year trip and travel time matrices must be defined. Distance matrices 
must also be defined for user classes for which VOC benefits need to be calculated. Charge matrices, 
representing for example fares, tolls and parking charges, are optional and need not be defined if there are 
no charges. The same file can be specified more than once, for example if the same distance matrix 
applies to a number of different user classes.

5.6.1 Table format

This table provides a list of all the trip and cost matrices to be read by TUBA. For each matrix the following 
are defined:
¡ the user class(es) to which the matrix applies
¡ the time slice(s) to which the matrix applies

_________________________

2 http://www.dft.gov.uk/webtag/documents/expert/pdf/unit3.5.4.pdf
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¡ the type of data, indicated by a single letter code: vehicle trips (V), person trips (P), travel time (T), 
distance (D), or charge (Cn)3  

¡ the matrix format: 1, 2 or 3 (see Appendix C)
¡ the scenario: 0 for DM, 1 for DS, a b c d or e for intermediate points
¡ the modelled year
¡ a factor for converting the data to the correct units (see below)
¡ the filename 

Matrix data is expected in the following units:

Table 5.1: Matrix data expected units
Data Units

Passenger or vehicle trips Trips per hour

Distance Kilometres

Time Hours

Charge Pence (perceived costs)

A factor can be defined to convert to the correct units. For example if a distance matrix is in metres then the 
appropriate factor to convert to kilometres is 0.001.

Details on matrix formats can be found in Appendix C

Note that format 3 matrices can contain data for multiple user classes and time slices. In this case the user 
classes and time slices contained in the matrix are defined as in the following example:

1-3;5;7-8

which indicates that the matrix contains data for classes 1, 2, 3, 5, 7 and 8. 

When the cursor is in the file name column of the data entry template the browse button on the toolbar can 
be used to select a matrix file.

5.6.2 Data checks

A number of checks are made on the consistency of the input matrices as follows:
¡ Trip matrices defined for both scenarios and for each modelled year
¡ Time matrix defined for each trip matrix
¡ Distance matrix defined for vehicle matrices
¡ Consistency in use of user classes between scenarios 
¡ Maximum matrix cell values
¡ Ratio of DM to DS travel times and distances

_________________________

3 ‘n’ is the charge type number, as defined in the economics file. For example, define the type as C3 for a charge type 3 matrix. ‘C’ 
will be interpreted as ‘C1’
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The checks on the maximum values of matrix cells are as follows:

Table 5.2: Maximum value of data cells
Data Maximum

Passenger or vehicle trips 100 000 trips/hr

Distance 1000 km

Time 10 hrs

Charge 50 000 pence 

These checks are intended to identify possible errors in the units (e.g. minutes instead of hours) or 
anomalies in the source data.

The checks made on the ratio of DM to DS costs (time and distance) (r) are as follows:

Table 5.3: Data checks
Value of r Action

r<A or r>D Serious warning 

A<r<B or C<r<D Warning 

B<r<C OK, no warning

The values of A, B, C and D are:

Table 5.4: Limit values
A B C D

.33 .67 1.5 3

These checks are made because in the case of large changes in cost the rule of a half which is used to 
calculate user benefits may not be valid.

Currently the number of matrices that can be defined is limited to 1500, although this can be increased if 
required – please contact technical support.

5.6.3 Intermediate points

Intermediate points are used when there are large cost changes between the DM and DS scenarios. For a 
detailed explanation of when they are needed and how to obtain suitable data please refer to the user 
guidance document.

Matrices for intermediate points are identified using scenarios a,b,c,d, and e. If there is just one 
intermediate point this must be scenario a. If there are two they must be scenarios a and b and so on. 

When there is more than one intermediate point TUBA assumes that scenario a is the point closest to the 
DM, b the next closest and so on. This means that adding new intermediate points to a TUBA run already 
using intermediate points may require relabelling of the scenarios. TUBA will check that the values in the 
trip, time, distance and cost matrices are consistent with this ordering. For example, the number of trips in 
scenario a must be between the number of trips in the DM and the DS. Any intermediate points that do not 
follow this sequence will result in a warning and that intermediate point being ignored. 
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5.7 Sectors

Sectors are used to convert highway and public sector models, which may have different zoning systems, 
to a common base. They are also used to aggregate zones to simplify the analysis of the spatial distribution 
of benefits. The use of sectoring will reduce the memory requirements of the program and can significantly 
improve run times.

Sectoring has no impact on the total benefits, costs and revenues; it only affects the level of spatial detail 
available through the detailed results analysis option.

Each sector is an exact aggregation of one or more zones, i.e. sector boundaries cannot cut through a 
zone. The format of the sector definition file is given in Appendix D.

In this table the sector file for each mode is defined. The same file can be used for more than one mode. If 
no file is defined for a particular mode then the default sectoring method, as defined by the ‘use zones as 
sectors’ parameter in the scheme file PARAMETERS table, will be used.

The Browse button on the toolbar can be used to select sector files.
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6.1 Main output file

All runs of TUBA produce a standard text output file with the extension .OUT. This can be viewed via the 
View->Results->Text menu option. The file contains various types of information as described in the 
following sections. Detailed table formats can be found in Appendix E.

The same data is also available in html format: View->Results->html. See Section 6.2 for more information 
on the html output files. Advantages of viewing the html files include a menu bar for navigating between 
tables and easier copying and pasting of tables to other applications.

Unless stated otherwise, monetary values are reported as perceived costs in thousands of pounds in base 
year market prices, discounted to the present value year.

A separate guidance document on checking TUBA results is supplied with the software or can be 
downloaded from the web site http://www.dft.gov.uk/tuba/ .

6.1.1 Input summary

A brief summary of key input information including run names, input file names, details of the appraisal 
period and a summary of the number of modelled hours.

6.1.2 Errors and warnings

A full list of warnings, serious warnings and errors. Warnings and serious warnings indicate possible 
anomalies in the input data and should be investigated. Errors will cause the TUBA calculation to stop and 
will need to be resolved in order for TUBA to run to completion.

Certain warnings and serious warnings relating to matrix data can occur many times for a given set of input 
data. These are grouped together, with matrix cells ranked in decreasing order of seriousness, identifying 
the user class, time slice, year and scenario and the matrix values (after the application of any matrix 
factor) in question. This applies to the following warnings:

Table 6.1: TUBA warnings and their causes
Warning Likely cause

Ratio of DM to DS time or distance too high/low Possible error in input data, otherwise large cost change 
which may invalidate rule of half

Matrix cell value too high Error in input matrix, wrong units or incorrect matrix factor 
specified

Origin – destination speed too high/low Error in input data (time/distance)

One of DM and DS (but not both) time or distance is zero Attempting to use TUBA with a new mode. Contact 
technical support for advice.

For very large data sets it is possible to receive a ‘Not enough memory’ error. To resolve this select the 
‘Run one user class at a time’ option in the Run Settings template. If this fails to solve the problem then 
sectoring should be used with as few sectors as possible and if necessary allocating all zones to a single 
sector.

6. Output 
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6.1.3 Economics file differences

The standard economics file is compared against the economics file in use for a TUBA run. The tables that 
differ between the two are output one after the other in the text output, and side by side in the HTML 
output. 

6.1.4 Scheme costs

Three tables are used to report scheme costs. The tables DM_SCHEME_COSTS and 
DS_SCHEME_COSTS report undiscounted costs in base year market prices by mode, year and cost type. 
These tables can be used to check the automatic calculation of preparation and supervision costs and the 
use of default profiles.

The table PRESENT_VALUE_COSTS gives total investment and operating costs (i.e. excluding delays, 
grant or subsidy and developer contributions)  by year and mode for the DM and DS schemes and reports 
the difference.

6.1.5 Trip matrix totals

The table TRIP_MATRIX_TOTALS reports the annualised trip totals by submode, time period and 
modelled year, for the do minimum and do something scenarios.

6.1.6 User costs

This table reports total user costs (time, charge, fuel and non-fuel VOC) for the DM and DS scenarios. Note 
that in a fixed trip matrix appraisal the user benefits will be the difference between DM and DS costs. This 
is not true in a variable trip matrix appraisal.

6.1.7 Fuel consumption

This table reports the total fuel consumption by fuel type and vehicle type for the DM and DS scenarios. 
The units are thousands of litres.

6.1.8 Carbon emissions

This table reports the total carbon emissions, in tonnes, for the DM, DS and the increase for each year and 
for each vehicle type. These figures are also presented monetised using the low, central and high values 
for carbon emissions. 

6.1.9 Carbon emissions by time period

This table gives a break down of carbon emissions and carbon benefits by time period for each of the 
modelled years and for the overall totals in the appraisal period. 
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6.1.10 User benefits and government and operator revenues

A series of tables reports user benefits (time, charge, fuel and non-fuel VOC), operator revenues and 
government indirect tax revenues, disaggregated by the various categories:
¡ Mode
¡ Submode
¡ Person type
¡ Purpose
¡ Time period

Note that the results by mode are given for each year of the appraisal period. For the other categories 
results are given for the modelled years and a total across all years.

6.1.11 Benefits by distance and by time saving

The TUBA output gives six tables that provide the breakdown of benefits by time saving and a breakdown 
by distance. These include:

¡ NON_MONETISED_TIME_BENEFITS_BY_TIME_SAVING
¡ MONETISED_TIME_BENEFITS_BY_TIME_SAVING
¡ TOTAL_BENEFITS_BY_TIME_SAVING
¡ NON_MONETISED_TIME_BENEFITS_BY_DISTANCE
¡ MONETISED_TIME_BENEFITS_BY_ DISTANCE
¡ TOTAL_BENEFITS_BY_DISTANCE

The information can be used to analyse whether benefits are concentrated on short-distance trips or long-
distance trips; and whether the scheme benefits are made up of short time savings or longer time savings.

6.1.12 Sensitivity

The SENSITIVITY table reports the total user benefits as a percentage of the total DM user costs for each 
mode and modelled year. This is calculated using data in the DM&DS_USER_COSTS and  MODE tables.

The information in this table can be used to assess the sensitivity of the user benefits calculated by TUBA 
to the level of convergence in the transport model; this is a requirement of the latest WebTAG advice. The 
smaller the numbers reported in this table, the more sensitive the results. WebTAG gives guidance on 
determining whether model convergence is adequate, given the size of the scheme benefits.

6.1.13 Transport Economics and Efficiency (TEE) Table

A summary of the results in TEE table format which is consistent with the WebTAG documents released 
with IN DRAFT status in January 2010

6.1.14 Public Accounts table

A summary of the costs of the project to the public sector.  This table is consistent with the WebTAG
documents released with IN DRAFT status in January 2010
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6.1.15 Analysis of Monetised Costs and Benefits

A summary of all monetised costs and benefits assessed by TUBA. There may also be other significant 
costs and benefits, some of which cannot be presented in monetised form.  Where this is the case,  the 
analysis presented may  not provide a good measure of value for money and should not be used as a basis 
for decisions.  

For example, accident benefits will have to be added by the user. 

This table is consistent with the WebTAG documents released with IN DRAFT status in January 2010

6.2 html files

A total of four files are generated by TUBA for viewing the data in html format. If the main output file is 
called root.out then the html files will be as follows:

root.html The main html containing the frameset. Open this file in your internet browser to view 
the results. This file links to the following two files

root_menu.html Contains the navigation menu. This file should not be opened directly; it is used by 
root.html

root_res.html Contains all the TUBA results. This file can be opened on its own, but if you do so the 
navigation menu will not be available.

root.xml Unformatted TUBA results in xml format. This may be useful if you wish to develop 
your own applications to read TUBA results. Please contact TUBA support for more 
information.

If you wish to send html format results to someone else there are three options available:

¡ Just send root_res.html. The navigation menu will not be available.
¡ Send all three html files. The recipient should open root.html; the navigation menu will then be available
¡ While viewing root.html in your internet browser choose File-Save As and under File Type select Web 

Archive (*.mht). This single mht file can then be sent to the recipient. This may not work with all internet 
browser software.

6.3 .tbn file

A file with the extension .tbn is produced, with the same root file name as the main output file. This contains 
the time benefits for each mode and modelled year, cross-tabulated according to the change in trip 
numbers and travel time at OD cell level. The contents of this file can be used to decide whether it is 
necessary to run TUBA with intermediate points.
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6.4 Export data option

If the scheme parameter ‘Detailed results’ is set to Yes then TUBA will output a binary file containing fully 
disaggregate results by year, submode, purpose, person type, period, origin and destination. This file can 
be interrogated using the Analysis->Export Data menu option.

Figure 6.1: Export data template

Figure 6.1 shows the export data template. A drop down box for each category is used to select a single 
value or ‘All’ data. An output file name must also be defined, using the Browse button if desired. The output 
file will be in CSV format for opening in a spreadsheet for further analysis or graphing.
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A.1. General

This Appendix contains the detailed file format specification for the economic parameters file. It is intended 
as a guide when editing the file directly, rather than via the user interface. The user is referred back to 
Chapter 4 for a fuller explanation of the data items.

The two input data files are structured in a similar way, consisting of a sequence of tables each of which 
contains a particular type of data. Tables are identified by a title in upper case which must match the table 
names given below, including underscores. All lines beginning with an asterisk ‘*’ are treated as comments. 
All tables are in free format, i.e. there are no fixed field widths but all fields must be separated by at least 
one space.

A.2. Parameters

Table name: PARAMETERS

Field Attribute Data Type Range / Description

1 Name character string

2 Value (various) integer, real, logical or character value

3 description character any string

The parameters currently recognised are:

TUBA_version the current TUBA version

base_year The base year for which the parameters are defined, i.e. all reported values will be in base 
year prices

pres_val_year The present value year; all costs and benefits will be discounted to this year

RPI_base The value  of the Retail Price Index in the economic base year

av_ind_tax The average rate of indirect taxation in the economy

carbon_values The value of one tonne of carbon emissions; three figures are required, separated by a 
space, representing low, high and central valuations

A.3. Mode

Table name: MODE

Field Attribute Data Type Range / Description

1 Mode number integer value in the range 1-5

2 Mode name character any string

Appendix A. Economic parameters file
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Mode represents the highest level of aggregation for reporting purposes; in particular, results in the TEE 
table are displayed by mode. Scheme details and costs are also specified by mode.

A.4. Vehicle type /submode

Table name: VEHICLE_TYPE/SUBMODE

Field Attribute Data Type Range / Description

1 vehicle type/submode number integer value in the range 1-10

2 Mode number integer value in the range 1-5

3 new submode? char Y or N 

4 P&R? char Y or N

5 type (personal or freight) char per/fre

6 Name char any string

A.5. Person type

Table name: PERSON_TYPE

Field Attribute Data Type Range / Description

1 person type number int value in the range 1-20

2 Type char Driver or Passenger ( D / P )

3 Name char any string

A.6. Purpose

Table name: PURPOSE

Field Attribute Data Type Range / Description

1 purpose number int value in the range 1-10

2 type (consumer or business) char C or B or O

3 Name char any string

A.7. Fuel type

Table name: FUEL_TYPE

Field Attribute Data Type Range / Description

1 fuel type number int value in the range 1-2

2 Name char any string
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A.8. Time periods

Table name: TIME_PERIODS

Field Attribute Data Type Range / Description

1 time period number int value in the range 1-10

2 Name char any string

A.9. Benefit breakpoints table

The table has two rows.

Field Data type and range Description

1 String ‘Distance’ or ‘TimeSaving’ Identifies whether this row contains breakpoints for Distance or Time 
Savings

2 Real
>=0 for ‘Distance’;
any value for ‘TimeSaving’

First breakpoint. Distance breakpoints in kms, Time saving breakpoints 
in minutes

3 “ Second breakpoint

4 “ …

5 … …

6 Etc, up to 10 breakpoints …

Example:

* Breakpoints for breakdown of benefits by distance and time saving
Distance 5 10 15 20 30
TimeSaving -5 -2 0 2 5

The breakpoints are open ended. So, if the breakpoint values defined are a,b,c,d then the ranges they 
define are:

<a
≥a, <b
≥b, <c
≥c, <d
≥d

Note that the lower end of the range is greater than or equals; the upper end strictly less than.
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A.10. Charges

Table name: CHARGES

Field Attribute Data Type Range / Description

1 charge type  number int value in the range 1-10

2 sector char pri, cen or loc

3 Name char any string

A.11. Discount rate

Table name: DISCOUNT_RATE

Field Attribute Data Type Range / Description

1 start year int >0 (1 = current year)

2 end year int >0, ≥start year

3 Rate real >0

A.12. Value of time

Table name: VALUE_OF_TIME

Field Attribute Data Type Range / Description

1 vehicle type/submode int value in the range 1-10

2 person type int value in the range 1-20

3 VOT purpose 1 real Perceived VOT (p/hr)

4 VOT purpose 2 real

n+2 VOT purpose n real where n is up to 10

In this table values of time (VOTs) are defined by person type, purpose, and vehicle type/submode 
combination. The VOT for any such combination that is not explicitly defined is taken as zero.

VOTS are defined in pence per hour as perceived costs. Note that they should also be at factor cost for 
business purposes – TUBA will convert them to market prices.

A.13. Value of time growth

Table name: VALUE_OF_TIME_GROWTH

Field Attribute Data Type Range / Description

1 start year int 4 digit year (eg 2001)

2 end year int 4 digit year (eg 2005)

3 growth rate real growth in % for purpose 1, default=0
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Field Attribute Data Type Range / Description

4 growth rate real growth in % for purpose 2, default=0

n+2 growth rate real growth in % for purpose n, default=0

A.14. Average indirect tax changes

Table name: AV_IND_TAX_CHANGES

Field Attribute Data Type Range / Description

1 start year int 4 digit year (eg 2001)

2 end year int 4 digit year (eg 2005)

3 growth real % increases in average indirect tax rate (% pa), 

A.15. Charge tax rates

Table name: CHARGE_TAX_RATES

Field Attribute Data Type Range / Description

1 charge type int value in the range 1-10

2 charge final real tax on charges final consumption

3 charge intermediate real tax on charges intermediate consumption

A.16. Charge tax rate changes

Table name: CHARGE_TAX_RATES_CHANGES

Field Attribute Data Type Range / Description

1 start year int 4 digit year (eg 2001)

2 end year int 4 digit year (eg 2005)

3 charge type int value in the range 1-5

4 Final real % p.a. change 

5 intermediate real % p.a. change

A.17. Fuel costs

Table name: FUEL_COST

Field Attribute Data Type Range / Description

1 fuel type int value in the range 1-2

2 resource cost real resource value of fuel, pence per litre
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Field Attribute Data Type Range / Description

3 Duty real duty, pence per litre

4 VAT real Value Added Tax (%)

5 carbon emissions real Carbon grams/litre used

A.18. Fuel cost changes

Table name: FUEL_COST_CHANGES

Field Attribute Data Type Range / Description

1 start year int 4 digit year (eg  2001)

2 end year int 4 digit year (eg  2005)

3 fuel type int value in the range 1-2

4 resource cost change real % change p.a. in resource value of fuel

5 duty change real % change p.a. in duty

6 VAT change real % change p.a. in VAT

7 carbon_density_change real % change p.a

A.19. Carbon value changes

Table name: CARBON_VALUE_CHANGES

Field Attribute Data Type Range / Description

1 start year int 4 digit year (eg  2001)

2 end year int 4 digit year (eg  2005)

4 cost change (rate) real % change p.a. in value of carbon emissions

5 cost change (absolute) real absolute change £/p.a. in value of carbon emissions

A.20. Fleet

Table name: FLEET

Field Attribute Data Type Range / Description

1 vehicle type/submode int value in the range 1-10

2 fuel type 1 split real % fuel type 1

3 fuel type 2 split real % fuel type 2

n+1 fuel type n split real % fuel type n

A.21. Fleet changes

Table name: FLEET_CHANGES
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Field Attribute Data Type Range / Description

1 start year int 4 digit year (eg  2001)

2 end year int 4 digit year (eg  2005)

3 vehicle type/submode int value in the range 1-10

4 fuel type 1 split change real % p.a. change 

5 fuel type 2 split change real % p.a. change

n fuel type n-1 split change real % p.a. change

A.22. Fuel consumption

Table name: FUEL_CONSUMPTION
Field Attribute Data Type Range / Description

1 vehicle type int value in the range 1-10

2 fuel type int value in the range 1-2

3 a - fuel consumption real fuel consumption coefficients

4 b - fuel consumption real

5 c - fuel consumption real

6 d-fuel consumption real

7 cut_off_speed int 3 digit (km/hr)

VOC parameters should only be defined for vehicle types/submodes that obtain their data from a highway 
model, such as cars or LGVs. If VOC parameters are not defined for a particular vehicle type/submode 
then VOC benefits are not calculated.

a, b, c, d fuel consumption coefficients

These give the fuel consumed in litres per km using the formula:






































+++=
3

T

D
d

2

T

D
c

T

D
ba

D

T
consumedFuel

where D and T are the distance in kilometres and the time in hours. The maximum value of D/T is restricted 
to the cut-off speed specified in the last column of the fuel consumption table for fuel consumption 
purposes.

A.23. Efficiency

Table name: FUEL_EFFICIENCY

Field Attribute Data Type Range / Description

1 start year int 4 digit year (eg  2001)

2 end year int 4 digit year (eg  2005)
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Field Attribute Data Type Range / Description

3 vehicle type int value in the range 1-20

4 fuel type int value in the range 1-2

5 eff real efficiency gains (%)

A.24. Non-fuel Vehicle Operating Costs

Table name: NON_FUEL_VOC

Field Attribute Data Type Range / Description

1 vehicle type int value in the range 1-10

2 a - non-fuel VOC - business real non-fuel resource cost coefficients

3 b - non-fuel VOC - business real

4 a - non-fuel VOC - consumer real

5 b - non-fuel VOC - consumer real

a, b non fuel VOC coefficients

These give the non-fuel VOC (in pence) when used in the formula:

bTaDVOCfuelNon +=−

where T is the travel time in hours and D is the distance in kilometres.

Different non-fuel VOC parameters are defined for business and consumer trips, reflecting the difference in 
vehicle fleet composition.

Non-fuel VOC parameters and the value of fuel should be input as resource values (i.e. exclusive of all 
taxes).

A.25. Non-fuel VOC changes

Table name: NON_FUEL_VOC_CHANGES

Field Attribute Data Type Range / Description

1 start year int 4 digit year (eg  2001)

2 end year int 4 digit year (eg  2005)

3 vehicle type int value in the range 1-20

4 non-fuel real % change in non-fuel VOC coeffs
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A.26. Non-fuel VOC tax rates

Table name: NON_FUEL_TAX_RATES

Field Attribute Data Type Range / Description

1 vehicle type/submode int value in the range 1-10

2 final real tax on non-fuel VOC final consumption

3 intermediate real tax on non-fuel VOC intermediate consumption

A.27. Non-fuel VOC tax rate changes

Table name: NON_FUEL_TAX_RATES_CHANGES

Field Attribute Data Type Range / Description

1 start year int 4 digit year (eg 2001)

2 end year int 4 digit year (eg 2005)

3 vehicle type/submode int value in the range 1-10

4 Final real % p.a. increase 

5 intermediate real % p.a. increase

A.28. Purpose split

Table name: DEFAULT_PURPOSE_SPLIT

Field Attribute Data Type Range / Description

1 Vehicle type/submode int value in the range 1-10

2 purpose int value in the range 1-10

3 period 1 split real split value (%) in period 1

4 period 2 split real split value in period 2

n+2 period n split real split value in period n

Purpose splits should add up to 100 when summed over each vehicle type/submode and time period 
combination.

A.29. Person factors

Table name: DEFAULT_PERSON_FACTORS

Field Attribute Data Type Range / Description

1 vehicle type/submode int value in the range 1-10

2 purpose int value in the range 1-10
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Field Attribute Data Type Range / Description

3 person type real value in the range 1-20

4 period 1 real person type factor in period 1

5 period 2 real person type factor in period 2

n+3 period n real person type factor in period n

Default person factors are an extension of occupancy factors, but recognise that a more detail 
categorisation than driver/passenger may be required. Occupancies can be deduced by summing the 
factors over all person types for a particular vehicle type/submode, purpose and time period.

If the user is unable to input matrices by person type then these factors are used to calculate mean VOTs 
for each vehicle type/submode, purpose and time period combination. 

A.30. Person factors

Table name: DEFAULT_PERSON_FACTORS_CHANGE

Field Attribute Data Type Range / Description

1 start year int 4 digit year (eg  2001)

2 end year int 4 digit year (eg  2005)

3 vehicle type int value in the range 1-10

4 Purpose int value in the range 1-10

5 person type real value in the range 1-20

6 period 1 real % change in person type factor, period 1

7 period 2 real

n+5 period n real % change in person type factor, period n

A.31. Preparation & Supervision Costs

Table name: PREPARATION&SUPERVISION

Field Attribute Data Type Range / Description

1 Mode int 1-5

2 prep: SI real Prep costs, stage SI, % of land and construction costs for 
this mode

3 prep: PC real

4 prep: PR real

5 prep: OP real

6 prep: WC real

7 superv real Supervision costs, % of land and construction costs for 
this mode
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B.1. Parameters

Table name: PARAMETERS

Field Attribute Data Type Range / Description

1 Name char string

2 Value (various) integer, real, logical or character value

3 description char any string

The parameters currently recognised are:
¡ TUBA_version
¡ The current TUBA version
¡ run_name
¡ A descriptive title for this TUBA run.
¡ do_min_name
¡ A descriptive title for the do-minimum scheme.
¡ do_som_name
¡ A descriptive title for the do-something scheme.
¡ first_ yr
¡ The first year for which user benefits can be calculated.
¡ horizon_ yr
¡ The last year for which user benefits should be calculated (usually 60 years after the opening year).
¡ modelled_ yrs

The years for which trip and cost matrices will be defined (between first_yr and horizon_yr). If the opening 
year and horizon year are the same then there can be only one modelled year. Otherwise there must be at 
least two modelled years (a maximum of 6 is allowed).

detail

If ‘yes’ then the detailed results file is output. If ‘no’ the detailed results file is suppressed.

current_yr

The first year for which scheme costs are incurred. 

print_warn

Whether to print all warning messages (‘All’) or limit the number of each warning type (in which case the 
parameter value should be set to the desired maximum).

p&r_car_speed

The average speed of the car leg of park and ride trips. Used in the calculation of vehicle operating costs 
for park and ride trips.

Appendix B. Scheme-specific file
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zones_as_sectors

If ‘yes’ then TUBA assumes a one to one correspondence between zones and sectors.. If ‘no’ then all 
zones are allocated to one sector. This parameter has no effect on the sectoring system for modes for 
which a scheme file has been explicitly defined.

B.2. Time slices

Table name: TIME_SLICES

Field Attribute Data Type Range / Description

1 time slice int value in the range 1-32

2 duration (mins) real length of time slice

3 annualisation factor real how many of this time slice in a whole year

4 time period int value in the range 1-10

5 description char

B.3. Schemes (DM and DS)

Table name: SCHEMES_DM, SCHEMES_DS

Field Attribute Data Type Range / Description

1 mode int value in the range 1-5

2 first construction year int first year of construction for scheme for this mode

3 opening year int 4 digit year - opening year for scheme for this mode

4 stage char current preparation stage for this mode: SI, PC, PR, OP 
or WC

B.4. Costs (DM and DS)

Table name: DO_MIN_COSTS, DO_SOM_COSTS

Field Attribute Data Type Range / Description

1 type char
C,L,M,O, S, P, G or D: construction, land, maintenance, 
operating, supervision, preparation, grant/subsidy or 
developer or other contribution

2 mode int value in the range 1-5

3 sector char pri/cen/loc (private sector, central govt, local govt)

4 cost real/char total cost (£1000s), or ‘default’ for TUBA to calculate (P & 
S costs only)

5 price char M (market prices) or F (factor cost)

6 RPI real RPI in quarter for which costs are estimated
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B.5. Profile (DM and DS)

Table name: DO_MIN_PROFILE, DO_SOM_PROFILE

Field Attribute Data Type Range / Description

1 year int 4 digit year (eg 2000)

2 mode int value in the range 1-5

3 % construction real % of total construction cost for this mode that is spent in 
this year

4 % land real

5 % prep real

6 % super real

7 % maintenance real

8 % operating real

9 % grant/subsidy real

10 % developer or other 
contribution real

-1 can be entered as the % for land, preparation, supervision or operating costs to indicate that the default 
profile should be used.

B.6. Delay costs (DM and DS)

Table name: DO_MIN_DELAY_COSTS, DO_SOM_DELAY_COSTS

Field Attribute Data Type Range / Description

1 year int 4 digit year (eg 2000)

2 mode int value in the range 1-5

3 construction and maintenance 
delays - business

real value of delay costs during construction and maintenance 
(£1000s base year market prices)

4 construction and maintenance 
delays – commuting real “

5 construction and maintenance 
delays - other real “

6 construction and maintenance 
delays - freight real “

B.7. Benefit changes

Table name: BENEFIT_CHANGE

Field Attribute Data Type Range / Description

1 start year int 4 digit year (eg  2021), after last modelled year
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Field Attribute Data Type Range / Description

2 end year int 4 digit year (eg  2069), up to 60 years after ‘first year’

3 vehicle type int value in the range 1-10

4 Benefit growth, time period 1, %pa real

3+n Benefit growth, time period n, %pa real

B.8. User classes

Table name: USER_CLASSES

Field Attribute Data Type Range / Description

1 class number int value in range 1-32

2 vehicle type/submode int value in range 1-10

3 purpose int value in range 1-10

4 person type int value in range 1-20

Purpose and person type can be zero, representing ‘all purposes’ and ‘all person types’ respectively. 

B.9. Input matrices

Table name: INPUT_MATRICES

Field Attribute Data Type Range / Description

1 matrix number int value in the range 1-1500

2 user class number - single value (formats 1,2) or range for format 3 matrices

3 time slices - single value or range for format 3 matrices

4 type char veh trips(V), passenger trips(P), time(T), charge(Cn) or 
distance(D)

5 format int 1,2,3

6 scenario int 0=do-min,  1=do-som, a b c d or e for intermediate points

7 year int 4 digit year (eg 1996)

8 factor real factor to convert to standard units (default=1.0)

9 filename char

B.10. Sectors

Table name: SECTORS

Field Attribute Data Type Range / Description

1 mode number integer value in the range 1-5

2 sector file name char name of sector file name for this mode
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Three different formats are available in TUBA. They are designed to be compatible with the most widely-
used transport modelling packages.

Format 1

Row Field Attribute Data Type Range / Description

n m value for origin n, destination m real non-negative; CSV format

Example:
0,20,15
25,0,15
20,30,0

(3 x 3 matrix with zero intra-zonal trips)

This is a ‘square’ matrix format, with values defined for all origin-destination pairs.

Format 2

Field Attribute Data Type Range / Description

1 origin int

2 destination int

3 value real non-negative, CSV format

Example:
100,101,20
101,100,15

(value of 20 from zone 100 to zone 101, and 15 from zone 101 to zone 100)

Note that data only needs to be defined for origin-destination pairs with non-zero values.

Format 3

Field Attribute Data Type Range / Description

1 origin int

2 destination int

3 user class int

4 value in first time slice real non-negative

5 value in second time slice real non-negative

n+3 value in nth time slice real non-negative

Appendix C. Matrix formats
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Example:
100  101  1  20 15 25
101  100  1  30 25 20

(data for user class 1 for three time slices)

Formats 1 and 2 are comma separated variable formats. Format 3 is ‘free’ format, i.e. there must be a 
space between fields.

In format 1 origin and destination numbers are not defined explicitly and are allocated to a sequential 
numbering system. Also in format 1 data must be defined for every single OD pair. In formats 2 and 3 only 
data for OD pairs with non-zero trip numbers needs to be defined.
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Field Attribute Data Type Range / Description

1 zone number integer zone number

2 sector number integer sector to which this zone belongs

The sector definition file consists of two columns. The first identifies the zone number and the second 
defines the sector to which it belongs. Sectors must be defined for all zones.

In the following example zones 1 and 2 belong to sector 1 and zones 3 and 4 belong to sector 2:
1  1
2  1
3  2
4  2

Appendix D. Sector file format
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Like the input files the output file is divided into a series of tables. Unless stated otherwise, all costs and 
benefits are reported as perceived costs and market prices in thousands of pounds. Monetary values are 
discounted to the present value year unless otherwise stated.

E.1. Input summary

This table contains a summary of key input data.

E.2. Economics File Comparison summary

This section summarises the differences between the standard economics file and the economics file used 
in the appraisal. If the standard economics file has been used this section is empty.

E.3. Errors and warnings

This is a full list of errors, warnings and serious warnings encountered during the calculations. Errors cause 
the program to stop and therefore their cause must be rectified. The program will carry on after a warning 
or serious warning; it is the responsibility of the user to check that they are not caused by errors in the input 
data.

E.4. DM and DS scheme costs

Field Attribute Data Type Range / Description

1 mode string

2 year integer

3 prep real preparation costs 

4 super real supervision costs

5 constr real construction costs

6 land real land costs

7 maint real maintenance costs

8 oper real operating costs

9 grant/sub real grant/subsidy costs

These tables give undiscounted scheme costs in base year market prices. Their main use is in checking 
the application of default calculations for preparation and supervision costs and in the use of default 
profiles.

E.5. Present value costs

Field Attribute Data Type Range / Description

1 mode string

2 year integer All cost years and total

3 DM scheme costs integer £, discounted to PVY

4 DS scheme costs integer 

Appendix E. Output file (*.out)
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Field Attribute Data Type Range / Description

5 Difference integer DS-DM scheme costs

This is a tabulation of the scheme costs in base year prices discounted to the present value year. It 
contains investment and operating costs only (i.e. it excludes the grant/subsidy and delays that were 
defined in the scheme costs table).

E.6. Trip matrix totals

Field Attribute Data Type Range / Description

1 submode string

2 year integer modelled years only

3 time period string

4 do-min trip totals integer annualised trip totals

5 do-some trip totals integer 

This table reports annualised trip numbers, using the same units as the input matrices (i.e. vehicle trips or 
person trips).

E.7. DM and DS user costs

Field Attribute Data Type Range / Description

1 mode integer

2 year integer Modelled years only

3 do-min : user time integer 

4 do-min : user charges integer split by charge type

5 do-min : fuel VOC integer 

6 do-min : non fuel VOC integer 

7 do-som : user time integer 

8 do-som : user charges integer 

9 do-som : fuel VOC integer 

10 do-som : non fuel VOC integer 

This is a tabulation of total user costs in the DM and DS scenarios. For example, the DM total time is the 
value of the total travel time in the DM scenario.

In a fixed trip matrix appraisal the user benefits will be the DM cost minus the DS cost. This will not be the 
case with a variable trip matrix.
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E.8. Fuel consumption

Field Attribute Data Type Range / Description

1 vehicle type integer

2 year integer Modelled years and all years total only

3 do-min : fuel type 1 integer total fuel consumption, thousands of litres

4 do-min : fuel type 2 integer 

5 do-som : fuel type 1 integer 

6 do-som : fuel type 2 integer 

Total fuel consumption by vehicle type, fuel type and scenario (DM and DS). These are not monetary units 
and are therefore not discounted.

E.9. Carbon emissions

Field Attribute Data Type Range / Description

1 vehicle type integer

2 year integer Year or All for total over all years 

3 DM tonnes integer DM emissions, 1000s of tonnes

4 DS tonnes integer DS emissions, 1000s of tonnes

5 DS-DM tonnes integer Increase in emissions, 1000s of tonnes

6 DM value (low) integer Value of DM emissions (low)

7 DS value (low) integer Value of DS emissions (low)

8 DS-DM value (low) integer Increase in value (DS-DM) (low)

9 DM value (central) integer Value of DM emissions (central)

10 DS value (central) integer Value of DS emissions (central)

11 DS-DM value (central) integer Increase in value (DS-DM) (central)

12 DM value (high) integer Value of DM emissions (high)

13 DS value (high) integer Value of DS emissions (high)

14 DS-DM value (high) integer Increase in value (DS-DM) (high)

E.10. Carbon emissions by time period

This table gives a break down of carbon emissions and carbon benefits by time period for each of the 
modelled years and for the overall totals. The table below  gives an example of the format for an appraisal 
with AM, IP and PM time periods; and 2010, 2025 as modelled years:

Emissions (tonnes) Cost (£000s,low) Cost (£000s,medium) Cost (£000s,high)

Period Year DM DS Increase DM DS Increase DM DS Increase DM DS Increase

AM peak 2010

AM peak 2025

PM peak 2010

PM peak 2025

Inter-peak 2010
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Emissions (tonnes) Cost (£000s,low) Cost (£000s,medium) Cost (£000s,high)

Period Year DM DS Increase DM DS Increase DM DS Increase DM DS Increase

Inter-peak 2025

AM peak Total

PM peak Total

Inter-peak Total

E.11. Mode

Field Attribute Data Type Range / Description

1 mode integer

2 year integer All years and total

3 benefits : user time integer 

4 benefits : user charges integer split by charge type

5 benefits : fuel VOC integer 

6 benefits : non fuel VOC integer 

7 benefits : operator revenues integer split by charge type

8 benefits : indirect taxes integer 

User benefits, operator revenues and indirect taxes by mode and year for all years from the scheme 
opening year to the horizon year.

E.12. Submode

Field Attribute Data Type Range / Description

1 veh type/ submode integer

2 year integer Modelled years and all years total only

3 benefits : user time integer 

4 benefits : user charges integer split by charge type

5 benefits : fuel VOC integer 

6 benefits : non fuel VOC integer 

7 benefits : operator revenues integer split by charge type

8 benefits : indirect taxes integer 

User benefits, operator revenues and indirect taxes by vehicle type/submode and year for all modelled 
years.

E.13. Person types

Field Attribute Data Type Range / Description

1 person type integer
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Field Attribute Data Type Range / Description

2 year integer Modelled years and all years total only

3 benefits : user time integer 

4 benefits : user charges integer split by charge type

5 benefits : fuel VOC integer 

6 benefits : non fuel VOC integer 

7 benefits : operator revenues integer split by charge type

8 benefits : indirect taxes integer 

User benefits, operator revenues and indirect taxes by person type and year for all modelled years.

E.14. Purpose

Field Attribute Data Type Range / Description

1 purpose integer

2 year integer Modelled years and all years total only

3 benefits : user time integer 

4 benefits : user charges integer split by charge type

5 benefits : fuel VOC integer 

6 benefits : non fuel VOC integer 

7 benefits : operator revenues integer split by charge type

8 benefits : indirect taxes integer 

User benefits, operator revenues and indirect taxes by purpose and year for all modelled years.

E.15. Period

Field Attribute Data Type Range / Description

1 period integer

2 year integer Modelled years and all years total only

3 benefits : user time integer 

4 benefits : user charges integer split by charge type

5 benefits : fuel VOC integer 

6 benefits : non fuel VOC integer 

7 benefits : operator revenues integer split by charge type

8 benefits : indirect taxes integer 

User benefits, operator revenues and indirect taxes by period and year for all modelled years.

E.16. Benefits broken down by time saving and distance

There are six output tables with the same format - three giving the breakdown of benefits by time saving, 
three for the breakdown by distance:



255479/ITD/ITW/04/K 27 May 2010
http://pims01/pims/llisapi.dll/open/17625033

TUBA User Manual

54

¡ NON_MONETISED_TIME_BENEFITS_BY_TIME_SAVING
¡ MONETISED_TIME_BENEFITS_BY_TIME_SAVING
¡ TOTAL_BENEFITS_BY_TIME_SAVING
¡ NON_MONETISED_TIME_BENEFITS_BY_DISTANCE
¡ MONETISED_TIME_BENEFITS_BY_ DISTANCE
¡ TOTAL_BENEFITS_BY_DISTANCE

An example format is given below.

NON_MONETISED_TIME_BENEFITS_BY_TIME_SAVING
Time benefits (thousands of person hrs) by size of time saving

Vehicle 
type/submode

Purpose Year <-5 mins -5 to -2
mins

-2 to 0 
mins

0 to 2
mins

2 to 5 
mins

>5 mins

Car Business 2010

Car Business 2025

Car Business Total

Car Commute 2010

Car Commute 2025

Car Commute Total

…

Rail Other 2010

Rail Other 2025

…

E.17. Sensitivity

Field Attribute Data Type Range / Description

1 mode string

2 sensitivity real user benefits divided by DM user costs

2+n-1 “ “ n is number of modelled years

User benefits, by mode and modelled year, as a percentage of total DM user costs.

E.18. Economy: Economic Efficiency of the Transport System (TEE 
Table)

A summary of the benefits (transport users and private sector providers) in TEE table format, giving the 
present value of benefits (PVB) of the scheme. 
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E.19. Public Accounts Table

A summary of the costs of the project to the public sector, giving the present value of costs (PVC) of the 
scheme.

E.20. Analysis of Monetised Costs and Benefits

A summary of all monetised costs and benefits assessed by TUBA. There may also be other significant 
costs and benefits, some of which cannot be presented in monetised form.  Where this is the case,  the 
analysis presented may  not provide a good measure of value for money and should not be used as a basis 
for decisions.  

For example, accident  benefits will have to be added by the user.
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This file contains the time benefits for each mode and modelled year cross-tabulated according to the 
change in travel time and trip numbers at OD level. It is used to assess the impact of large cost changes on 
total benefits and to decide whether it is necessary to use intermediate points.

Field Attribute Data Type Range / Description

1 range of change in trip numbers char e.g. 10%-20%

2 time benefits for first range of 
time changes integer Discounted £000s.

N+1 time benefits for Nth range of 
time changes integer

Appendix F. Partitioned time benefits file 
(*.tbn)
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